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Using This Guide

This guide describes the supported configurations for running Avid MediaCentral Cloud UX in a 
virtual environment using VMware® vSphere®. It provides details to help you select supported host 
servers and to optimally configure the virtual machines. Throughout this guide, Avid MediaCentral 
Cloud UX might be referred to as “MCUX” for brevity.

This guide is intended for system administrators and other personnel who are familiar with VMware 
technology and the Linux operating system. The VMware examples and illustrations included in this 
document might not reflect your actual version of software. For the latest information on features of 
the user interface, see your VMware documentation.

c This document is subject to change and is periodically updated. Before you begin an 
installation, check the Avid Knowledge Base for the latest version. The following Knowledge 
Base article contains links to documentation for each MediaCentral Cloud UX release:

http://avid.force.com/pkb/articles/en_US/user_guide/MediaCentral-CloudUX-Documentation

Revision History

Date Revised Changes Made

September 20, 2023 MediaCentral Cloud UX 2023.7 is the last release to support traditional “spinning disk” 
HDD’s for all MediaCentral Cloud UX volumes (OS and Data). If you are using 
VMware with a shared SAN array, the SSD requirement applies to any shared storage 
that hosts a virtualized deployment of MediaCentral Cloud UX.

Organizations that are still using standard HDD’s should begin to plan for a hardware 
upgrade to prepare for future Feature or LTM releases of MediaCentral Cloud UX.

September 8, 2021 Clarification on the CPU qualification process:

Avid performs all system qualification using Intel-based CPUs. Avid cannot ensure 
equivalent performance, functionality, or compatibility if your equipment includes 
processors from other vendors such as AMD, or others.

May, 2021 Qualification of VMware vSphere v7.0.

The sda volume must be at least 300GB for all new VMs.

December, 2020 This version updates the minimum amount of RAM for all MediaCentral Cloud UX 
virtual machines to 128GB.

November 8, 2019 Initial release.

http://avid.force.com/pkb/articles/en_US/user_guide/MediaCentral-CloudUX-Documentation
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published. You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes available. To view 
these online versions, select ReadMe from the Help menu, or visit the Knowledge Base at http://
avid.force.com/pkb/articles/en_US/user_guide/MediaCentral-CloudUX-Documentation.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Avid Knowledge Base. Online services are available 24 hours per day, 7 days per 
week. Search this online Knowledge Base to find answers, to view error messages, to access 
troubleshooting tips, to download updates, and to read or join online message-board discussions.

Symbol or Convention Meaning or Action

n
A note provides important related information, reminders, recommendations, and 
strong suggestions.

c
A caution means that a specific action you take could cause harm to your 
computer or cause you to lose data.

> This symbol indicates menu commands (and subcommands) in the order you 
select them. For example, File > Import means to open the File menu and then 
select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list indicate 
that you perform one of the actions listed.

(Windows), (Windows 
only), (macOS) or (macOS 
only)

This text indicates that the information applies only to the specified operating 
system, either Windows, or macOS.

Bold font Bold font is primarily used in task instructions to identify user interface items and 
keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the mouse 
action. For example, Command+Option+C or Ctrl+drag.

http://avid.force.com/pkb/articles/en_US/user_guide/MediaCentral-CloudUX-Documentation
http://avid.force.com/pkb/articles/en_US/user_guide/MediaCentral-CloudUX-Documentation
http://www.avid.com/search?q&site=kbase&date=Anytime&dnav
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Avid Training Services
Avid makes lifelong learning, career advancement, and personal development easy and convenient. 
Avid understands that the knowledge you need to differentiate yourself is always changing, and Avid 
continually updates course content and offers new training delivery methods that accommodate your 
pressured and competitive work environment

For information on courses/schedules, training centers, certifications, courseware, and books, please 
visit https://www.avid.com/learn-and-support and follow the Training links, or call Avid Sales at 
800-949-AVID (800-949-2843).

https://www.avid.com/learn-and-support


1 Virtual Environment Best Practices

The following topics describe best practices for a MediaCentral Cloud UX virtual environment using 
VMware:

• Overview

• Qualified VMware Versions

• Minimum vSphere Environment Specifications

• VMware Validation Environment Details

• Managing and Monitoring Virtual Resources

• Benefits of Maintaining VMs on Shared Storage

• MediaCentral Cloud UX VM Recommendations

• Search Grid Recommendations

Overview

Virtualizing MediaCentral Cloud UX provides the following benefits:

• Deploy and operate multiple Avid systems such as MediaCentral Cloud UX, MediaCentral 
Newsroom Management, MediaCentral Production Management, and others on a single physical 
server.

• Consolidate hardware to get higher productivity from fewer physical servers. 

• Reduce power consumption and cooling requirements.

• Simplify the process of managing IT operations.

• Upgrade software in a production environment faster and with reduced risk.

For an overview of virtualization using VMware, see the following link:

https://www.vmware.com/pdf/virtualization.pdf

For detailed information about VMware and vSphere, see the following link:

https://www.vmware.com/products/vsphere.html

https://www.vmware.com/products/vsphere.html
https://www.vmware.com/pdf/virtualization.pdf
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Definition of Terms

The following table defines some of the commonly used terms associated with virtualization:

Term Definition

Virtualization Refers to the act of creating a virtual (rather than actual) version of something, including (but 
not limited to) a virtual computer hardware platform, operating system (OS), storage device, or 
computer network resources.

VM Virtual machine

vCPU Virtual CPU 

ESXi The OS of a VMware host server. This can refer to either the free release, or any one of the 
licensed editions. The same installer is used for all (same installation instance can have any of 
the licenses applied to it).

VMware host Physical server with ESXi installed on it. Utilized for physical resources such as CPU, RAM, 
network, SAN connections, or local datastores.

vCenter server A server used to administer VMware host servers or vSphere clusters. The vCenter server can 
be one of the following:

• A Windows server (physical or virtual)

• A virtual appliance

vCenter provides tools and a central interface for managing all connected VMware hosts and 
VMs, including the ability to migrate VM's from one host to another using vMotion. vCenter 
also simplifies the process of updating your hosts using the VMware Update Manager 
component. If the VMware Update Manager is not used, administrators must update each host 
manually via the command line interface (CLI).

Virtual appliance A pre-configured VM that’s available for importing into an existing vSphere environment. 
Often using a Linux OS.

vSphere Combination of ESXi host servers and a vCenter server configuration. 

vSphere client A Windows or Mac system capable of connecting to the vSphere server. The connection is 
established through either a locally installed client application or a web portal.

vMotion Also known as a migrate task, vMotion can be used to move a live VM from one host server, or 
one datastore, to another without any down time. Often coupled with shared storage. Storage 
vMotion can be within a single host server or SAN (or group of LUNs on a single SAN 
configuration/cluster). If an administrator needs to move a VM between host servers with only 
local datastores, the task is only available on a ‘cold’ (powered off) VM.

vSphere Fault Tolerance vSphere Fault Tolerance provides continuous availability for virtual machines by creating and 
maintaining a Secondary VM that is identical to, and continuously available to replace, the 
Primary VM in the event of a fail-over situation.

vSphere HA A feature that enables a cluster with High Availability. If a host goes down, all virtual machines 
that were running on the host are promptly restarted on different hosts in the same cluster.

When you enable the cluster for vSphere HA, you specify the number of hosts you want to be 
able to recover. If you specify the number of host failures allowed as 1, vSphere HA maintains 
enough capacity across the cluster to tolerate the failure of one host. All running virtual 
machines on that host can be restarted on remaining hosts. By default, you cannot turn on a 
virtual machine if doing so violates required fail over capacity.

MPIO Multi Path In/Out. A common configuration to improve performance with shared storage.
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Qualified VMware Versions

VMware vSphere 6.5 Update 1 is the minimum supported version for running MediaCentral Cloud 
UX in a virtual environment. Avid has also tested VMware vSphere 6.7 and VMware vSphere 7.0. 
For more detailed MediaCentral version information, see “Limitations and Notes” on page 17.

Avid recommends applying security patches to the VMware host servers on a quarterly basis (at 
minimum). If higher security risks are identified, shorter intervals of time are recommended.

Whenever planning an upgrade to the VMware software, you should make sure to plan for the 
appropriate down-time. Upgrades often require one or more reboots of the VMware servers. 
Additionally, Avid recommends taking a snapshot of the vCenter Server before any update.

For complete details regarding VMware version compatibility, see https://www.vmware.com/.

Minimum vSphere Environment Specifications

For optimal performance, Avid recommends that you meet or exceed the specifications listed in 
“Host Server VMware Validation Configuration” on page 10. In general, you should follow VMware 
best practices when setting up a system.

For more information on VMware best practices, see:https://www.vmware.com/techpapers.html

The following table lists the minimum vSphere environment specifications for deploying 
MediaCentral Cloud UX as a virtual machine. When making purchasing decisions, Avid 
recommends that you use the following specifications, their equivalent, or better.

IOPS Input/Output Operations Per Second. A unit of measure for datastores (local or shared).

virtual core Similar to the concept of physical processors cores and sockets, a virtual core is a subdivision of 
a virtual socket, For example, an Intel E5-2640 v3 Xeon processor has 8 cores per processor. A 
VM can be configured to have X virtual cores per virtual socket allocated to it. Such as 2 virtual 
sockets with 2 virtual cores each, giving the VM 4 vCPUs.

LUN Logical unit number. A reference to a logical grouping of drives.

VMXNET3 VMXNET Generation 3. This is a virtual network adapter designed to deliver high performance 
in virtual machines (VMs) running on the VMware vSphere platform. VMXNET3 has the same 
features as the VMXNET2 adapter but with added functionality to minimize I/O virtualization 
overhead. To enable VMXNET3, VMs need to be on virtual hardware version 7 or later and 
may need VMware Tools installed, depending on which guest operating system (guest OS) is 
being used.

VMXNET3 allows for 10 Gb (or higher) network speeds. If the VMware host’s network adapter 
is not capable of 10 Gb speeds, two VMs located on the same host can still take advantage of 
the higher bandwidth as the network traffic is not leaving the host server.

Term Definition

Processor E5-2600 v3 2.6 GHz per core, base frequency. E5-2600 v4 or later recommended.

n Avid performs all system qualification using Intel-based CPUs.  Avid cannot 
ensure equivalent performance, functionality, or compatibility if your equipment 
includes processors from other vendors such as AMD, or others.

https://www.vmware.com/techpapers.html
https://www.vmware.com/
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VMware Validation Environment Details

This section lists the specifications for the host servers and SAN used for the Avid VMware 
validation environment. Avid followed the VMware best practices for setting up the validation 
environment.

Host Server VMware Validation Configuration

Avid used the Dell PowerEdge R730 as a validation system for the host server and the vSphere 
cluster. The following table lists the technical details of the server:

Number of Processors 2 physical sockets per host. Set processors to performance options. Do not use power 
saving settings.

RAM Sufficient to provide requirements without exceeding 75% of RAM installed in host 
server.

Datastore/storage 

(VM storage location)

Varies depending on actual servers/services being used.

Network connections Be able to provide a 1 Gb connection per virtual machine. This can be a group of 1 Gb, 
or one or more 10 Gb connections, depending on your environment. If possible, Avid 
recommends using a group of 10Gb connections for maximum throughput.

Minimum vSphere license Standard Edition.

Operating system vCenter (Standard) server is available as software installation for a Windows Server / 
VM or as a virtual appliance provided by VMware. Avid highly recommends running 
vCenter as a Windows VM rather than the VMware virtual appliance.

As a reminder, ESXi and vCenter are the components that make up vSphere.

Processor Intel Xeon E5-2640 v3

n Avid performs all system qualification using Intel-based CPUs.  Avid cannot 
ensure equivalent performance, functionality, or compatibility if your equipment 
includes processors from other vendors such as AMD, or others.

Form factor A 2U system (R730) was used for testing to allow greater flexibility for adding PCI 
cards and extra drives. 

Number of Processors 2

Processor Base Frequency 2.6 GHz

Number of Cores 8 per processor

Number of Threads 16 per processor

Intel Smart Cache 20 MB

QPI Speed 8 GT/sec

RAM 128 GB DDR4 RDIMM - ECC

Drives Tested with SAN instead of internal drives

PCIe 3.0 Slots 6
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SAN VMware Validation Environment Configuration

This section lists the specifications for the EqualLogic PS6210X used for VMware validation.

For details on the EqualLogic PS6210X, see the following link:

https://www.dell.com/support/home/en-us/product-support/product/equallogic-ps6210x/docs

Power Supply Dual, Hot-plug, Redundant Power Supply (1+1), 495W

Networking QLogic 57800 2x10Gb SR/SFP+ + 2x1Gb BT Network Daughter Card, with SR Optics 
for the following

• iSCSI SAN: Qualified with Dual 10GbE w/SFP + CNA (iSCSI offload). Note that 
SAN connections will depend on the site SAN configuration.

• vMotion and Host Management: Dual 1GbE for each

Intel i350 quad port 1GbE NIC

Additional NICs tested:

• QLogic 57810 DP 10Gb SR/SFP+ Converged Network Adapter, with SR Optics

• Mellanox MT27500 ConnectX3

Operating system VMware ESXi 6

Model EqualLogic PS6210X configured as RAID 50

RAID Controller Dual controllers with 16GB non-volatile memory per controller 

Network Interfaces 10GbE connectivity

Management network One (1) 100BASE-TX per controller

Interface ports Two (2) 10GBASE-T with RJ45 or two (2) 10GbE SFP+ for fibre or twin-ax copper 
cabling per controller

Cache level 16GB per controller

Controller configured active/standby

One controller is active, the second is standby. Ports on the active controller are fully 
active while connections are good. If one port on the active controller loses its connect, 
its mirror on the standby controller becomes live. Maximum configured transfer rate is 
20Gbps from SAN.

Drives 24 total hard drives (2 configured as spares). Configured RAID 50. Total available size 
is of approximately 17 drives providing 14.1 TB of space. 22 spindles are available for 
performance of array (spares are not “online” for capacity/use). Drives are 2.5 inch; 
10,000 RPM; 12Gb/s SAS drives (Seagate ST900MM0006 Enterprise Performance 
10K HDD) For details on the Seagate drives used, see the following link:

https://www.seagate.com/www-content/product-content/savvio-fam/savvio-10k/savvio
-10k-6/ru/docs/savvio10k6-ds1768-1cr-1301us.pdf

https://www.dell.com/support/home/en-us/product-support/product/equallogic-ps6210x/docs
https://www.seagate.com/www-content/product-content/savvio-fam/savvio-10k/savvio-10k-6/ru/docs/savvio10k6-ds1768-1cr-1301us.pdf
https://www.seagate.com/www-content/product-content/savvio-fam/savvio-10k/savvio-10k-6/ru/docs/savvio10k6-ds1768-1cr-1301us.pdf
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Managing and Monitoring Virtual Resources

All virtual machines contain the following basic components:

• An OS on a virtual disk

• Virtual memory

• Virtual processors (vCPU)

• A virtual network adapter

As long as the host resources are not oversubscribed, multiple VMs can run on the same host server. 
Host hardware and VM resource requirements can vary greatly, so the number of simultaneous 
virtual machines can also vary. System administrators must monitor resource usage to determine if 
the host can support additional VMs.

In the Avid validation environment, the SAN contains the physical drives that are presented as 
multiple LUNs (logical unit numbers). vCenter takes the LUNs and uses them as datastores for the 
VMs. A resource load-balancing utility called Distributed Resource Scheduler (DRS) is used to 
balance the load against the datastores.

Physical servers often benefit from more CPU resources than are needed without showing any 
negative effects. However, this is not the case for virtual machines. There are many cases where 
allocating more vCPUs actually results in performance degradation, especially if the applications on 
the VM are not multi-threaded. When creating virtual machines, best practices suggest that you 
should allocate the minimum amount of resources to the VM and increase the resources as needed.

VMware Networking Best Practices

For an overview of networking in a VMware environment, see the vSphere Networking guide at the 
following location: https://docs.vmware.com/en/VMware-vSphere/index.html

Best Practices for Working with Snapshots

VMware Snapshots are not backups. A snapshot file is a change log of the original virtual disk. Do 
not rely on it as a direct backup process. The virtual machine is running on the most current snapshot, 
not the original virtual machine disk (VMDK) files.

After creating a snapshot, the VM must read all information from the original image, plus the 
information in the change log. This inherently introduces performance degradation. Performance is 
further impacted if additional snapshots of the same VM are created. For this reason, it is best to 
avoid using snapshots with Avid virtual machines.

For additional information on working with Snapshots, see “Best practices for using snapshots in the 
vSphere environment” (article ID:1025279) on the VMware Knowledge Base at: 
https://kb.vmware.com/s/

https://docs.vmware.com/en/VMware-vSphere/index.html
https://kb.vmware.com/s/
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Monitoring VM Resources

Avid recommends that you enable the following Alarm Definitions from within vCenter server:

• Virtual machine CPU usage

• Virtual machine memory usage

• Host CPU usage

• Host memory usage

The trigger parameters should be left at the default settings. You must also enable email notifications 
and provide a monitored email address for these alarms. 

Benefits of Maintaining VMs on Shared Storage

When you design your virtual environment you must decide whether you want to store your VMs on 
shared storage or on the internal drives of the individual host servers. The shared storage option is 
preferred for multiple reasons. This section describes some of the benefits of using shared storage.

n Shared storage in this context refers to an external SAN array and not Avid shared storage.

VMs and vCenter Residing on Shared Storage

This method has the following benefits:

• All files that are used to build the VM are on the SAN. vCenter manages how the VMs use the 
host servers. 

• vCenter can automatically load balance the servers or you can use the vCenter application to 
manually load balance the system. Options are fully automated, partially automated, or manual.

• If a host server goes down, vCenter can be configured to automatically move the associated VMs 
to another host server. This includes the vCenter VM.

• Host servers do not need to contain hard drives. ESXi can be installed on flash media.

VMs Residing on one or two Host Servers with Internal Storage

This method has the following drawbacks:

• You store the VMs on the individual host servers. Relies on RAID card configuration options 
selected for performance.

• You must manually balance the VMs between the host servers. Moving a VM from one server to 
another requires that you shut down the VM and manually migrate the VM to the other host 
server.

• If a host server goes down, you lose access to the VMs that were running on that host until the 
host is restored.

The primary reason why one might prefer to have local, internal storage over a SAN array could be 
the cost of the array. However, once you eliminate the cost of RAID controllers and local 
enterprise-class drives, the cost delta between local and shared storage narrows significantly. This 
becomes especially true once you move beyond a single VMware host server.
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MediaCentral Cloud UX VM Recommendations

This section provides information on creating MediaCentral Cloud UX virtual machines.

Host Server and SAN Specifications

For host server recommendations, see “Host Server VMware Validation Configuration” on page 10. 
If you are not using a SAN and are using local storage, Avid recommends the following:

• For internal drives on a single standalone host: 8 15K RPM (or higher) SAS drives configured as 
RAID 10 using a Hardware RAID controller with NVRAM of 1 GB or greater. For example, 
Dell PERC H730.

For SAN recommendations, see “SAN VMware Validation Environment Configuration” on page 11. 
As with the host server specifications, Avid recommends that you requisition equivalent or better 
hardware.

For best results, Avid encourages system administrators to store both the VM and its virtual volumes 
on solid state drives to take advantage of the performance boost offered by these devices. This is 
especially true if you are creating a MediaCentral Cloud UX cluster where data is replicated between 
the nodes.

Common VM Settings

The following settings are common recommendations across all configurations:

• Enable “Memory Hot Plug” so that you can dynamically allocate RAM to the VM without 
shutting it down.

• Avid does not recommend enabling the vCPU “Hot Add” feature as this can disable vNUMA 
support for the virtual machine which can lead to a degradation in system performance. If you 
need to add additional vCPUs, you must shut down the virtual machine and then increase the 
system resources. For more information on shutting down a MediaCentral Cloud UX server, see 
“Power Cycling and Maintenance Mode” in the Avid MediaCentral | Cloud UX Installation 
Guide.

• When determining the number of cores, each virtual socket should include two virtual cores. For 
example a VM configured for 8 vCPUs would consist of 4 sockets, each with 2 cores.

You can add more cores per socket. However, the core count should always be an even number.

• You must install open-vm-tools and make sure that these tools are up to date. MediaCentral 
Cloud UX v2019.9 and later bundles Open VM Tools with the MediaCentral Platform ISO. The 
process for “Installing MediaCentral Cloud UX” on page 30 describes how to install this 
software package.

For more information, see Introduction to VMware Tools or Using Open VM Tools on the 
VMware Docs site. The VMware support for open-vm-tools page on the VMware Knowledge 
Base provides additional information.

• VMXNET 3 is the required network adapter for all virtual machines.

• To protect your most sensitive virtual machines, deploy firewalls in virtual machines that route 
between virtual networks with uplinks to physical networks and pure virtual networks with no 
uplinks.

https://docs.vmware.com/en/VMware-vSphere/6.7/com.vmware.vsphere.html.hostclient.doc/GUID-28C39A00-743B-4222-B697-6632E94A8E72.html
https://docs.vmware.com/en/VMware-Tools/10.1.0/com.vmware.vsphere.vmwaretools.doc/GUID-8B6EA5B7-453B-48AA-92E5-DB7F061341D1.html
https://kb.vmware.com/s/article/2073803
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Allocating vCPUs and RAM

The amount of RAM and number of vCPUs that are assigned to a MediaCentral Cloud UX virtual 
machines varies depending on your organization’s workflow. To make this decision, you need to 
know which media formats are in use, as the number of concurrent playback streams vary per format.

The following table provides a guideline for MediaCentral Cloud UX stream counts at multiple 
resolutions in various environments tested by Avid. In addition to stream counts, each column shows 
the peak CPU and memory usage of the VM for each resolution.

All values in the table above are based on the Avid VMware validation environment. For details, see VMware Validation 
Environment Details.

At minimum, Avid recommends assigning at least 12 vCPUs and 128 GB of RAM for any 
MediaCentral Cloud UX VM. In general, you want to provide 1 vCPU for every 10 Kubernetes Pods. 
The number of deployed pods can vary per system and depends on the feature packs that you choose 
to install. You can determine the number of deployed pods through the Kubernetes Dashboard.

If you find that you do not have enough RAM to support the number of deployed pods after 
completing your MediaCentral Cloud UX installation on VMware, you can increase the amount of 
RAM allocated to your VM. For more information on the Kubernetes Dashboard, see “Working with 
Kubernetes” in the Avid MediaCentral | Cloud UX Installation Guide.

Planning for Core Resources

If you plan to deploy Multi Platform Distribution (MPD), Avid suggests that you increase the amount 
of RAM assigned to the VM by another 10 - 20 GB.

RAM and vCPU
12 vCPU with 
128GB RAM

16 vCPU with 
128GB RAM

20 vCPU with 
128GB RAM

24 vCPU with 
128GB RAM

AVC Intra 100 4 Streams

70% VM CPU

28 GB RAM

5 Streams

61% VM CPU

16 GB RAM

6 Streams

59% VM CPU

16 GB RAM

8 Streams

54% VM CPU

17 GB RAM

DNxHD 145 9 Streams

67% VM CPU

18 GB RAM

9 Streams

60% VM CPU

18 GB RAM

10 Streams

46% VM CPU

17 GB RAM

16 Streams

57% VM CPU

20 GB RAM

XDCAM HD 50 15 Streams

73% VM CPU

36 GB RAM

15 Streams

65% VM CPU

24 GB RAM

18 Streams

60% VM CPU

17 GB RAM

25 Streams

65% VM CPU

25 GB RAM

Proxy H.264 1080i 50 Streams

65% VM CPU

29 GB RAM

65 Streams

61% VM CPU

23 GB RAM

90 Streams

68% VM CPU

32 GB RAM

95 Streams

58% VM CPU

32 GB RAM
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Configuring Virtual Drives

MediaCentral Cloud UX servers deployed on physical hardware typically have two RAID volumes:

• A RAID-1 consisting of a pair of drives that host the operating system and applications. This is 
often a pair of 500 GB drives.

• A RAID-5 consisting of multiple drives for a playback file cache. This often consists of six to 
eight drives resulting in ~3TB or more of usable space.

The following table lists the recommendations for the virtual drives:

Volume Provisioning

When configuring the volumes later in the virtual machine creation process, you must make a 
decision about how the volumes will be configured. The options generally break down into two 
categories: thick or thin provisioning. Thick provisioning blocks out the requested space on the disk 
and prevents other virtual machines from allocating this space. When paired with the Eager Zero 
option, VMware writes zeros to the entire block to speed up the process of future writes.

Thin provisioning uses space only as needed —up to the maximum amount of GB that you allocate 
to the volume during the VM configuration process. Although thin provisioning might be more 
flexible for an organization running multiple VMs on the same SAN, it also can be slower when it 
comes to write performance.

Avid recommends the following when provisioning your virtual volumes:

• SDA volume: Avid recommends using Thin Provision as the SDA volume does not require the 
performance of the SDB volume.

• SDB volume: As this volume is used for media playback, Avid recommends that you specify 
Thick Eager Zero if you are using spinning disks in your SAN, or specify Thin Provision if you 
are using faster solid state drives.

System Storage (sda)

When you deploy CentOS during the MediaCentral Cloud UX installation process, you have the 
opportunity to review the disk partitioning information. You might notice that /var is generally the 
largest partition on the disk by default. This partition is used to house various databases, as well as 
the asset indexes that are required for MediaCentral Search. If you plan to include your system in a 
Multi-Site environment, your local system will store index information for each remote site at this 
same location. For these reasons, you’ll want to make sure that your sda drive is large enough to 
accommodate your workflow.

Configuration Virtual sda volume Virtual sdb volume

MediaCentral Cloud UX (without 
playback support)

300 GB (minimum) Not Applicable

MediaCentral Cloud UX (with playback 
support)

300 GB (minimum) Varies (50 GB minimum)
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While the storage requirements can vary based on your workflow, you can use the following general 
guidelines on the search index requirements to help you determine your storage needs:

• Asset Management (1 million assets, no multi-site)

- MongoDB: ~3.0 GB

- Elasticsearch: ~6.1 GB (no replica shard) or ~12.2 GB (cluster with 1 replica shard)

• Production Management (1 million assets, no multi-site)

- MongoDB: ~0.3 GB

- Elasticsearch: ~2.1 GB (no replica shard) or ~4.2 GB (cluster with 1 replica shard)

If you plan to deploy System Monitoring and you plan to use a MediaCentral Cloud UX server as a 
logging node, Avid recommends that you mount the monitoring data root directory (/var/lib/mon) 
to a dedicated disk or a dedicated partition of at least 150GB of an existing disk. For more 
information on this feature, see “Enabling System Monitoring” in the Avid MediaCentral | Cloud UX 
Installation Guide.

Cache Storage (sdb)

In several workflows, MediaCentral Cloud UX generates and locally caches transcoded media assets 
and system files. These workflows include:

• Working with multi-cam assets from a MediaCentral Production Management system — JPEGs 
of the multi-cam frames are stored on the cache

• Media playback for iOS and Android mobile apps where the cache is used to store MPEG-2TS 
(Transport Stream) media files that can be streamed to the mobile app

In these workflows MediaCentral Cloud UX must locally generate a compliant copy of the source 
media asset. This asset is then served to the requesting application. The asset is also cached in 
anticipation of a subsequent playback request. In the case of multi-server deployments (a cluster), the 
cached assets are replicated across the servers to reduce future transcoding of the same asset on a 
different playback server.

Cached media assets are stored on the volume until space is required for new assets. MediaCentral 
Cloud UX monitors the storage and executes a cron job to remove older files if the disk space falls 
below 40% free space. This process is limited to media assets and does not affect non-media files 
such as Docker registry data.

In addition to the above workflows, the sdb volume might also be used for the following:

• AAF sequence data from MediaCentral Production Management

• (Enterprise Editing) Draft sequence data

• Non-media files such as Docker registry data, Helm chart repos, and more 

Limitations and Notes

The following limitations apply to running MediaCentral in a virtual environment:

• Virtualization is supported on MediaCentral Cloud UX v2019.9 and later

• Starting with MediaCentral Cloud UX v2021.3, VMware qualification is performed using 
vSphere v7.0 only

• vSphere fault tolerance is not supported
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Search Grid Recommendations

Nexidia Search Grid™ is a framework of services that MediaCentral Cloud UX uses to perform 
phonetic indexing of audio media for use with MediaCentral | Phonetic Index and the MediaCentral 
Cloud UX Search app. In a hardware-based environment, Avid requires you to install the Search Grid 
software on a separate server running CentOS. 

Avid supports installing and configuring Search Grid in a virtual environment. When sizing the VM, 
you must use the same recommendations that are specified in the “Search Grid Prerequisites” section 
of the Avid MediaCentral | Cloud UX Installation Guide.



2 Creating Virtual Machines

The processes outlined in this procedure describe the vSphere web client. The web client can be 
accessed by opening a web browser and navigating to: https://<vSphere server IP address or 
hostname>/vsphere-client.

n This section provides guidance for using VMware software. The images and menus described below 
might not match your version of VMware. If you find a variation in the following process, consult 
your VMware documentation for the most up-to-date menu locations, options, and features.

The following main topics are described in this chapter:

• Uploading the ISOs to the Datastore

• Creating a New Virtual Machine

Uploading the ISOs to the Datastore

Avid MediaCentral Cloud UX is delivered as a set of ISO files that include the CentOS operating 
system and the MediaCentral Cloud UX software.

• Avid MediaCentral Cloud UX Platform

This is the primary installer package that includes the CentOS operating system and core Avid 
installation components.

Example file name: mediacentral_platform_<build>.iso

• Avid MediaCentral Cloud UX Feature Packs

This package includes additional software to install MediaCentral Cloud UX application on the 
Platform.

Example file name: mediacentral_feature_packs_<build>.iso

Prior to creating the virtual machine, you must copy the MediaCentral Cloud UX Platform ISO 
(mediacentral_platform_<build>.iso) to the VMware datastore. This image is used to install the 
CentOS operating system and core Avid installation components on the virtual machine.

If desired, you can also copy the Feature Pack ISO to the VMware datastore as well. Doing so allows 
you to mount the ISO to the virtual optical drive later in the installation process. Alternatively after 
the operating system is installed, you can copy the ISO directly to the VM and mount the Feature 
Pack ISO as a file.

To upload an ISO to the datastore:

1. Open a web browser and log into the vSphere Web Client.

The web client can be accessed by navigating to: https://<vSphere server IP address or 
hostname>/vsphere-client.
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2. After you have logged in, click the Storage option from the Home menu on the left.

3. The pane on the left-side of the window shows the available datastores. Click on one of the 
datastores to select a location to upload the ISO file.

4. Click the Files tab in the panel on the right.

5. (optional) For organizational purposes, you might want to create a folder on the datastore to hold 
the ISO files. If desired, click the New Folder button to create and name a new folder.

6. Click on a folder in the datastore where you want the ISO file to reside.

If you do not select a folder, the file will be uploaded to the root directory of the datastore. You 
can move the file to a folder after the upload is complete, but this process requires additional 
steps.

7. Click the Upload Files button.

8. Browse to the location of the ISO file.

9. Select the file and click Open.

The upload process begins. You can view the progress of the upload in the status pane at the 
bottom of the page.

10. Once the upload has completed, proceed to “Creating a New Virtual Machine” on page 21.
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Creating a New Virtual Machine

The following process creates the virtual machine on which you install CentOS and MediaCentral 
Cloud UX. If you do not have access to create a VM (the option is grayed-out) or if you are unable to 
assign certain features within the VM (such as assigning a network adapter), see your vCenter 
administrator to request access to these features.

To create a new virtual machine:

1. Open a web browser and log into the vSphere Web Client.

The web client can be accessed by navigating to: https://<vSphere server IP address or 
hostname>/vsphere-client.

2. Select the “Hosts and Clusters” option on the left side of the interface.

3. Click the arrows on the left to expand the tree and explore your vSphere environment.

4. After you select a location for your new VM, right-click on the tree and select “New Virtual 
Machine” as shown in the following illustration.

The Create New Virtual Machine window opens.

5. Select the “Create a new virtual machine” option and click Next at the bottom of the window.
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6. The “Select a name and folder” pane opens.

a. Assign a logical name to the VM that follows your organization’s standard practices. This 
name only appears in the VMware interface and has no direct relation to the host name 
assigned to the virtual server that runs CentOS and MediaCentral Cloud UX.

b. If applicable, select a location in the Inventory for the VM. If you have a standalone 
VMware host, this option might not be available

c. Click Next.

7. Select a compute resource that the VM will reside under. This might be a host, cluster, or 
resource pool. Then click the ‘Next’ button.
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8. The “Select storage” pane opens.

a. VM Storage Policy: If your vSphere Administrator has created Storage Policies, apply the 
appropriate policy to this VM. If no policies have been created, this menu will not be active. 

b. Select a datastore location where the VM will reside.

Depending on how your datastore is configured, you could have multiple options such as a 
storage cluster composed of multiple datastores presented from a SAN, or a single datastore 
that’s either on a SAN or local to the host.

If you have different tiers (or performance levels) of datastores, be sure to select the 
appropriate option for your configuration. Storage tier examples could include a set of large, 
but slower spinning disks, or a set of fast but smaller solid state devices. Depending on your 
configuration, VMs can be migrated to a different datastore later with Storage vMotion, a 
licensed option included in vSphere Standard Edition and higher.

c. Click Next.

9. In the “Select compatibility” pane, select a version of ESXi that you want your VM to be 
compatible with and click Next.

For example, if the menu lists ESXi 6.5 and later, it indicates that the ESXi host server is running 
v6.5.

10. The “Select a guest OS” pane opens.

a. Select Linux in the “Guest OS Family” menu.

b. Select CentOS 7 (64-bit) in the “Guest OS Version” menu.

c. Click Next.
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11. The “Customize hardware” pane opens (default options shown).

The Customize hardware pane combines multiple menus (CPU, Memory, etc) and tabs (Virtual 
Hardware, VM Options, SDRS Rules) into a single window.

Click the arrow to the left of the CPU menu to reveal additional configuration options.
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12. The CPU options are revealed.

Select the following options in the CPU menu:

a. Select the number of virtual sockets and cores per socket for the VM. Review the 
information in “Allocating vCPUs and RAM” on page 15 as a guideline to determine the 
appropriate number of sockets and cores for your environment. 

The standard configuration and recommendation is to allocate two cores per socket.

b. Enable the Hardware virtualization check box to “Expose hardware assisted virtualization to 
the guest OS.” This option enhances performance of the VM by optimizing host resources.

If you have Enhanced vMotion Compatibility (EVC) mode enabled or plan to enable this 
feature in the future, do not select this setting.

c. Click the arrow to the left of the CPU menu to hide the options.

n Notice that when a menu item is altered, the color of the menu option changes from blue-gray to 
yellow and an asterisk (*) appears to the left of the menu option.
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13. Click the arrow to the left of the Memory menu to reveal additional configuration options.

Select the following options in the Memory menu:

a. Configure the amount of RAM to allocate to your VM.

Review the information in “Allocating vCPUs and RAM” on page 15 as a guideline to 
determine the appropriate amount of RAM to allocate to your VM.

c The MB / GB menu might default to MB (megabyte). Make sure to adjust this to GB 
(gigabyte).

b. Enable the “Memory Hot Plug” check box. This option allows you to increase the amount of 
RAM assigned to the VM while it is in use.

c. Click the arrow to the left of the Memory menu to hide the options.

14. Click the arrow to the left of the “New Hard Disk” menu to reveal additional configuration 
options.

Select the following options in the “New Hard Disk” menu to configure the “sda” disk which 
hosts the CentOS operating system and applications:

a. Select a capacity for the sda volume.

You must allocate at least 300 GB for this volume.

b. Select a Disk Provisioning method.

For more information, see “Volume Provisioning” on page 16.

c. Set the Location to: Store with the virtual machine

d. Click the arrow to the left of the “New Hard Disk” menu to hide the options.
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15. Click the arrow to the left of the “New SCSI controller” menu to reveal additional configuration 
options.

Select the following options in the “New SCSI controller” menu:

a. Leave the SCSI Bus Sharing menu at the default of None.

b. Set the Change Type option to “LSI Logic SAS.”

c. Click the arrow to the left of the “New SCSI controller” menu to hide the options.

16. Click the arrow to the left of the “New Network” menu to reveal additional configuration 
options.

Select the following options in the “New Network” menu:

a. Select a Port Group from the Network menu.

n If the Port Group you need to assign is unavailable, your vSphere user account may not have 
permissions to this network. See your vCenter administrator for access.

b. Enable the check box to “Connect at Power On.”

c. Set the Adapter Type menu to VMXNET 3.

d. Click the arrow to the left of the “New Network” menu to hide the options.

17. Click the arrow to the left of the “New CD/DVD Drive” menu to reveal additional configuration 
options.
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Select the following options in the “New CD/DVD Drive” menu:

a. In the first menu, select “Datastore ISO File” to associate the MediaCentral Cloud UX 
Platform ISO file with the virtual optical drive.

b. In the Select File window, browse to the location of the ISO, select it and click OK. This will 
populate the CD/DVD Media field.

c. Select the check box to “Connect At Power On.”

d. Click the arrow to the left of the “New CD/DVD Drive” menu to hide the options.

18. (if applicable) Remove the “New Floppy drive” by placing your cursor over the menu item. An 
“X” will appear on the right of the line item.

Click the “X” to remove the floppy drive.

19. If you are configuring a VM that will host video playback services, add a second Hard Disk to be 
used as the Linux “sdb” cache volume.

a. Select “New Hard Disk” from the New device menu and click Add.

This adds a second “New Hard disk” line to the bottom of the Virtual Hardware list.

b. Click the arrow to the left of the “New Hard Disk” menu to reveal additional configuration 
options.

c. Select a size for the volume.

The Disk Size for the sdb volume might vary. For configuration guidelines, see “Configuring 
Virtual Drives” on page 16.

d. Select the Disk Provisioning option.

For more information, see “Volume Provisioning” on page 16.

e. Click the arrow to the left of the “New Hard Disk” menu to hide the options.

20. Instruct the virtual hardware to enter the BIOS on the first boot of the virtual machine.

a. Click the VM Options tab at the top of the window.

b. Click the arrow to the left of the “Boot Options” menu to reveal additional configuration 
options.

c. Enable the check box to “Force BIOS setup.”

21. Configuration of the virtual hardware is complete. Click the Next button.

22. The final “Ready to complete” pane shows all the options you have configured for this virtual 
machine. Review the information to verify that all settings are correct.

23. Click Finish to complete the VM creation.

The virtual machine hardware is now ready to accept an operating system, proceed to “Installing 
and Configuring Software” on page 29 to continue the installation process.



3 Installing and Configuring Software

At this time, the virtual machine only represents virtual hardware. As with any installation, software 
must be added to create a fully functional system. In this section you will configure the virtual 
machine’s BIOS and be directed to additional resources that will allow you to install the operating 
system and the MediaCentral Cloud UX software.

This process consists of the following steps:

• Configuring the Virtual Machine BIOS

• Installing MediaCentral Cloud UX

Configuring the Virtual Machine BIOS

During the virtual machine configuration, you instructed the VM to enter the system BIOS on first 
boot. In this section you configure the virtual BIOS for use with MediaCentral Cloud UX.

To configure the virtual BIOS:

1. Before you can adjust the BIOS, you must first power-on the virtual machine.

a. Select the Virtual Machine from the Inventory.

b. From the Inventory menu, select Virtual Machine > Open Console. This opens a virtual 
display monitor for the VM.

c. Start the VM by selecting Virtual Machine > Power > Power On. This boots the VM for the 
first time and takes you into the system BIOS.
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2. Use your mouse to click inside the VM display window to switch keyboard control to the VM.

n To release the keyboard and mouse from the console window, simultaneously press the Ctrl and Alt 
keys (briefly) on a Windows keyboard. 

3. Set the System Time and System Date through the BIOS. The keyboard’s tab key is used to 
switch between the hour, minute, second and month, day, year.

4. Set the virtual floppy drive “Legacy Diskette A” to Disabled. Even though the device has been 
removed in the virtual hardware, it also needs to be disabled through the VM BIOS. Use the 
space bar to cycle through the options until the floppy is listed as Disabled.

n “Legacy Diskette B” should already be disabled. If it is not, disable the device.

5. Use the arrow keys to navigate to the Boot menu.

6. Use the plus and minus buttons on the keyboard to adjust the boot order to the following: 

t Hard Drive

t CD-ROM Drive

t Removable Devices

t Network boot

7. When done altering the BIOS settings, press F10 to “Save and Exit.”

8. Select Yes when prompted to “Save configuration changes and exit now?”

The system reboots and the MediaCentral Cloud UX installer screen is displayed.

Installing MediaCentral Cloud UX

At this point, you must refer to the Avid MediaCentral | Cloud UX Installation Guide for complete 
installation instructions. This document is available on the Avid Knowledge Base at: 

http://avid.force.com/pkb/articles/en_US/user_guide/MediaCentral-CloudUX-Documentation

The following steps provide guidelines and VM-specific processes.

To install MediaCentral Cloud UX on a virtual machine:

1. After reading the “Installation Prerequisites” chapter of the Avid MediaCentral | Cloud UX 
Installation Guide, continue to the “Software Installation and Configuration” section of the 
guide to begin the installation process.

As you have already mounted the MediaCentral Cloud UX Platform ISO to the virtual machine’s 
optical drive, the system will automatically boot into the installer for MediaCentral Cloud UX 
and CentOS.

n As the volumes associated with virtual machines should not include any preconfigured system 
partitions, you can skip the process for “Verifying Disk Partitioning” in the Software Installation and 
Configuration chapter of the guide.

2. After “Logging in to CentOS for the First Time”, you must run the following command to install 
the Open VM Tools:

yum install open-vm-tools

http://avid.force.com/pkb/articles/en_US/user_guide/MediaCentral-CloudUX-Documentation
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Open VM Tools optimizes your operating system for use in a virtual environment. For more 
information, see the following:

- https://kb.vmware.com/s/article/2073803

- https://docs.vmware.com/en/VMware-Tools/11.0.0/com.vmware.vsphere.vmwaretools.doc/GU
ID-8B6EA5B7-453B-48AA-92E5-DB7F061341D1.html

3. Continue to follow the instructions in the Avid MediaCentral | Cloud UX Installation Guide to 
complete the software installation and configuration process. 

From this point forward, the processes that are detailed in the Installation Guide apply to both 
dedicated server hardware and virtual machines. Avid supports deploying MediaCentral Cloud 
UX as either a single-server or a clustered configuration.

https://kb.vmware.com/s/article/2073803
https://docs.vmware.com/en/VMware-Tools/11.0.0/com.vmware.vsphere.vmwaretools.doc/GUID-8B6EA5B7-453B-48AA-92E5-DB7F061341D1.html
https://docs.vmware.com/en/VMware-Tools/11.0.0/com.vmware.vsphere.vmwaretools.doc/GUID-8B6EA5B7-453B-48AA-92E5-DB7F061341D1.html
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